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1.0 GAMMA SPECTROSCOPY OPERATIONS 
 

2.0 APPLICABLE MATRIX 
 

This section is not applicable to this specific operating procedure. 
 

3.0 DETECTION LIMIT 
 
This section is not applicable to this specific operating procedure as this procedure 
presents basic operation of equipment.  Project specific work plans and sample analysis 
methods should be referred to for specific required detection limits using this equipment. 
 

4.0 SCOPE AND APPLICATION 
 

This operating procedure provides instruction and requirements for the operation of 
CABRERA SERVICES, Inc. (CABRERA) gamma spectroscopy systems.  Instructions are 
provided for proper equipment setup, routine instrument operation, quality control 
measurements, in-field container component counting, geometry modeling, and spectrum 
file management. 
 

5.0 SUMMARY OF METHOD 
 

This procedure describes the use of the Gamma Acquisition and Analysis (GAA) 
application within standard Canberra Industries’ Genie-2000 software and general 
methods of performing gamma spectroscopy measurements.  This operating procedure 
has been revised to meet the requirements of the Department of Defense Quality Systems 
Manual (DoD, 2003) and to incorporate both laboratory and non-destructive assay 
operations from CABRERA’S former procedure, Gamma Spectroscopy Laboratory 
Operational Procedures, OP-029, Rev. 3.  

 
6.0 DEFINITIONS/ACRONYMS 

 
6.1 FWHM – Full Width at Half Maximum 

 
6.2 GAA – Gamma Acquisition and Analysis 

 
6.3 HPGe – High Purity Germanium 
 
6.4 ISOCS – In-situ Object Counting System 
 
6.5 LN2 – Liquid Nitrogen 
 
6.6 MCA – Multi-Channel Analyzer 
 
6.7 NIST – National Institute of Standards and Technology 
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6.8 SME – Subject Matter Expert 
 

7.0 INTERFERENCES  
  
 This section is not applicable to this specific operating procedure. 
 

8.0 SAFETY 
 

8.1 Personnel handling radioactive material are trained in accordance with Cabrera’s 
administrative procedure, AP-009 Training, and appropriate precautions will be 
adhered to.  

 
8.2 Appropriate As Low As Reasonably Achievable (ALARA) measures shall be 

used to minimize the potential for contamination and unnecessary dose when in 
the presence of radiological material. 

 
8.3 The detector systems utilize a high voltage.  Use caution when handling cables 

and other electrically powered elements of the systems; ensure elements are 
powered down before unplugging. 

 
8.4 Avoid skin contact with liquid nitrogen (LN2) to avoid frostbite.  When handling 

LN2, always use proper eye and skin protection, including cryogenic safety 
gloves, safety glasses and/or a face shield. 

 
8.5 The shielding for the detectors are comprised of painted lead. If the shielding gets 

scratched or cracked, alert the Safety Officer and take the necessary precautions. 
 
8.6 The detector systems can be extremely heavy. Take care to watch for pinch points 

and when lifting or moving parts of these systems. 
  

9.0 EQUIPMENT AND SUPPLIES 
 
9.1 Liquid nitrogen 

• Tank containing low (~22) Pounds per Square Inch (PSI) liquid nitrogen 
• Transfer dewar (optional) 
• Metal connection hose 
• Rubber tubing with clamps (optional) 
• Adjustable Crescent Wrench (~12”) 
• Face mask, apron, cryogenic gloves 

 
9.2 Detector 

• Dewar (for lab systems) 
• Composite cable 
• Detector Specification Sheet 
• Allen wrench (7/32”) 
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9.3 Multi-Channel Analyzer (MCA) 

• DSA 1000 or InSpector 2000 
• USB cable 
• RS-232 serial cable (for analog MCA only) 
• USB hardware key (for DSA-100 only) 

 
9.4 Shield 

• For lab units this will consist of a lead table and stackable rings with a sliding 
door on top. 

• For In-Situ Object Counting Systems (ISOCS) this will consist of a shield set: (4) 
annular shield rings (25 mm or 50 mm), steel spacer tubes, clamp screws, and 
detector clamps.  

• Standard/Philips screwdrivers and standard/SI Allen wrench sets. 
 

9.5 Uninterruptable power supply and conditioner and a digital voltmeter 
 

9.6 Computer with GENIE-2000 and ISOCS Geometry Composer software installed, 
printer, USB flash drive, extension cords with surge protectors, a printer with 
necessary accessories and a bound logbook. 
 

9.7 ISOCS systems may also require the use of the following equipment (actual list will 
vary depending upon need): 
• Detector Tripod 
• Detector Cart (hydraulic lift or Canberra standard) 
• Extra long Signal Cable 
• 12V car battery with A/C inverter 
• Source jig for daily QC measurements 

 
10.0 REAGENTS AND STANDARDS 

 
This section is not applicable to this specific operating procedure. 

 
11.0 SAMPLE COLLECTION, PRESERVATION, SHIPMENT, AND STORAGE 

 
This operating procedure applies strictly to the operation of the gamma 
spectroscopy counting systems; therefore this section is not applicable. 

 
12.0 QUALITY CONTROL 

 
12.1 Data collected with any high-purity germanium (HPGe) detector is considered 

invalid unless compliance with the quality assurance requirements stated herein is 
demonstrated and documented. 

  
12.2 Individuals performing measurements with CABRERA Gamma Spectroscopy 
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equipment shall be familiar with the requirements established in the current and 
approved version of this procedure, shall have a general knowledge of gamma 
spectroscopy principles and shall have successfully demonstrated operation and 
setup of the equipment. 

 
12.3 The instruments are susceptible to water/moisture damage and shall only be 

operated in wet environments when appropriate protective precautions are 
implemented.  The instruments should not be operated in very wet environments 
such as heavy precipitation. 

 
12.4 The instrument shall not be operated in environments where the ambient 

temperature exceeds 50° C or is less than -10° C (122° F and 14° F, respectively). 
 

12.5 Daily quality control checks shall be conducted each day the systems are used. 
Please see Section 14.4 of this operating procedure for further details regarding daily 
control checks. 

 
12.6 Quality control samples will be performed at the frequency prescribed in the 

project work plans, e.g., 10% means a QC count (lab duplicate, field duplicate, 
replicate, blank, etc.) will be performed on every tenth sample. 

 
12.7 If QC control samples do not pass the QC parameters stated in the project specific 

work plans or in the sample analysis procedure consult the Project HP or Lab 
Manager for further guidance. 

 
12.8 Laboratory replicate sample measurements are performed to test the 

reproducibility of the HPGe system.  They should be near identical counts of a 
single sample with all system parameters remaining constant between the two. 

 
12.9 Samples flagged to be replicates shall be marked with a “R” on the label and set 

aside for counting.  Replicates may be counted immediately or the next business 
day. Replicates MAY NOT be compiled for counting all on the same day. 

 
12.10 A method blank is a “zero-activity” sample run through the entire sample 

preparation and counting process to ensure that no biases exist in the laboratory 
and to ensure that the detector and/or shield interior has not become contaminated 
inadvertently. 

 
13.0 CALIBRATION AND STANDARDIZATION 

 
The gamma spectroscopy detectors shall be calibrated upon setup.  Calibrations 
and/or gain adjustments shall be performed when necessary as stated herein to 
ensure that the accuracy of measurement results is not compromised.  Please see 
Section 14.2.12 of this procedure for specific details regarding this process. 
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14.0 PROCEDURE 
14.1 GAA Screen and Fields 

The Acquisition and Analysis screen is shown in Figure 1.  Instrument controls and 
functions are performed via this screen.  The menu tool bar is the second line of the 
screen and begins with the word File.  Each of these words or menus has submenus, 
which can be obtained by single-clicking one of the main menus from the toolbar.  
Directly below the menu bar is a shortcut bar or toolbar, which eliminates the need 
for scrolling through the menu bar for frequently used tasks.  The top portion of the 
spectrum screen displays the spectral data and information about the spectrum. The 
very bottom of the screen displays the generated report of the spectrum upon 
analysis.  Any page of the report can be viewed by scrolling. 
 

 
 

Figure 1. GAA Screen with Analysis 
 
14.2 Basic Instrument Operation 
 14.2.1 Launching GAA 

GAA can be opened from the Windows desktop by double-clicking on the 
GAA Icon or by choosing Start, then Programs, then Genie-2000, then 
GAA.  Before opening the detector, the MCA must first be switched on.  
The switch is located on the left side of the InSpector, and in the back of 
the DSA.  

  14.2.2 Opening the Detector 
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Choose File (located on the menu bar), then Open Datasource.  Open source 
type Detector and select the specific detector (e.g. DET01). 

14.2.3 Applying High Voltage to the Detector 

Caution: Ensure that the detector has been properly cooled with liquid 
nitrogen (i.e. for approximately six hours) before performing this step 

Choose MCA (located on the menu bar), then Adjust.  A box will appear in 
the lower portion of the screen.  Select the HVPS tab.  Select the On button, 
after the Wait signal has disappeared from the top left corner of the Adjust 
box, and exit from the Adjust box by single-clicking on the Exit button. 

14.2.4 Selecting the Appropriate Time 
Choosing the appropriate count time can be accomplished by using the edit 
icon located on the shortcut menu bar or by selecting MCA, then Acquire 
Setup from the menu bar.  Enter the appropriate time where prompted.  
Count time must be entered as live time for the instrument dead time 
correction to function properly.  Refer to the project-specific QAPP or the 
SME for appropriate live time values. 

14.2.5 Starting/Stopping Data Acquisition 
In the main GAA screen, pressing the Start key under Acquire will cause 
data acquisition to begin.  The Start button will no longer be bold face when 
the acquisition begins.  Acquisition can be stopped at any time by pressing 
the Stop button located immediately to the right of the start button.  If 
acquisition is stopped and a preset time is entered (see Section 14.2.4), 
pressing the Start button will resume acquisition, which will continue until 
the preset time is reached. 

14.2.6 Dead Time Check 
In the Time Info section of the GAA display window can be found the Dead 
Time.  If the dead time increases to above 5% when no known radiological 
source is in the area or increases above 15% when a known radiological 
source is being measured, then contact the SME for evaluation. 

14.2.7 Entering Sample Information 
Descriptive information is entered to uniquely identify each acquired 
spectrum.  This can be done while data acquisition is in progress, or after 
acquisition has stopped. 
  
Click on Edit in the GAA window menu bar, then select Sample info from 
the Edit menu.  This will display the Edit Sample Information dialog box, 
which includes descriptive fields for: Sample Title, Collector Name, Sample 
Description, Sample ID, Type, Units, and Sample Geometry. 
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Figure 2. View of Edit Sample Information Dialog Box 
 
Editable fields are also provided for Quantity, Uncertainty, Random Error, 
and Systematic Error.  Select the ‘None’ button in the Buildup Type 
section.  If it is necessary to ensure that short-lived nuclides are 
appropriately decay-corrected, then you can enter the date the sample was 
collected in the ‘Sample Date’ field. 
 
Make all desired entries in the fields of the Edit Sample Information dialog 
box, then click on the OK button to save the information and exit this dialog 
box. 

14.2.8 Clearing Spectrum Data 
Pressing the Clear key under the Start and Stop buttons under Acquire will 
erase the spectrum data.  Remember to save current detector settings by 
choosing the save disk icon on the tool bar before clearing data. 

14.2.9 Information from the Spectrum Display 

In the Spectrum Display, the left and right arrow keys will move the 
spectrum cursor.  The cursor can also be moved via the mouse by single-
clicking in the area of interest or clicking and dragging with the mouse.  
The information bar above the Spectrum Display will indicate the energy 
level (keV) and channel number corresponding to the location of the 
cursor, as well as the total number of counts (cts) at that energy level, and 
the Preset/Elapsed time.  In Figure 1, the acquisition was completed, 
therefore, the elapsed time was 300 seconds and the preset time was 300 
seconds (300/300 is shown in Figure 1).  If the instrument had only 
reached 200 seconds of the preset 300 seconds, then the display would 
show 300/200.  

The default settings for the GAA display allow the spectrum display vertical 
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scale to automatically adjust when counts in any channel exceed the current 
vertical scale.  The initial vertical scale is 64.  The spectrum Vertical Full 
Scale (VFS) display scale can be expanded or contracted by pressing the up 
and down arrow, respectively. 

14.2.10 Creating/Deleting Regions of Interest 

While in the Spectrum Display, a temporary ROI is established by using 
the Control and L keys and the Control and R keys, to define the 
beginning point and the ending point of the ROI, respectively.  
Information on an ROI is obtained by pressing either the Next or Prev 
buttons until Marker Info is displayed, see Figure 3.   

Integral is the total number of counts within the ROI.  Area displays the net 
counts in a region.  An ROI can be made permanent, by selecting the Add 
ROI menu item under the DISPLAY menu. 
 

 
Figure 3. GAA Screen with Marker Info Displayed 
 
 

14.2.11 Adjusting Amplifier Gain and ADC Zero 
Prior to the start of each counting session the system alignment should be 
checked.  If the energy gain or ADC zero is beyond acceptable limits, they 
must be adjusted. 



Onsite Laboratory Procedures Manual          OP-029, Rev. 3 
 

 9 of 15

 
To check and adjust the amplifier gain and ADC zero settings, a suitable 
check source should be placed near the detector during spectral data 
acquisition.  This check source should emit photons with emission rates 
sufficient to produce readily detectable photopeaks.  A NIST-traceable 
source may be used for this purpose but it is not mandatory. 
 
The centroid channel and corresponding energy value for each reference 
photopeak should be compared to the expected values.  Observed photopeak 
centroids should typically be within +/- 0.5 keV of the expected energy 
values.  Adjust the vertical full scale of the displayed spectrum and use the 
Expand On button, as appropriate, to view the reference photopeaks. 
 
From the MCA window, click Acquire Start and note the position of the 
photopeaks in the spectrum (specific to the source being used).  If 
necessary, amplifier gain and/or ADC zero settings can be changed by 
selecting Adjust from the MCA menu.  This will display the Adjust dialog 
box. 
 
The scroll bars in the Amplifier ‘Fine’ gain, or Superfine ‘S-fine’ gain 
sections of this dialog box should then be used to make the appropriate 
changes.  After each change, clear any previous spectral data and start a 
new acquisition to evaluate the new settings. 
 
When spectral data acquisition using a gamma source with known 
photopeak locations indicates that the centroid channel of each reference 
photopeak is within +/- 0.5 keV of the expected energy values, the new 
settings are deemed acceptable.  Click on the Exit button to exit the 
Adjust dialog box. 
 
To save the new parameter values, click on File in the GAA window menu 
bar, then select Save from the File menu. 

14.2.12 Energy and Efficiency Calibrations 
Detector calibrations will be performed as needed by, or with, the assistance 
of an individual qualified to perform detector calibrations. 

14.2.13 Saving a Spectral Data File 
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After spectral acquisition has stopped, the spectral data and related 
information can be saved in a file.  This step is required before analyses of 
the acquired spectrum can be performed. 
 
Click on File in the GAA window menu bar, then select Save as from the 
File menu.  This will display the Save As dialog box.  Enter the desired 
name, up to eight characters which will be followed by the .CNF extension in 
the File name field. 
 
You may also enter an appropriate supplemental text string (up to 32 
characters) in the Description field. Enter text that will be helpful in selecting 
this file when attempting to identify it at some later time. 
 
Click on the OK button to save the file and exit the Save As dialog box. The 
default directory used to store these files is GENIE2K\CAMFILES. 
 
To collect additional spectra, clear existing spectral data from the graphics 
region of the GAA window. 

14.2.14 Loading Calibration Parameters 
Canberra’s Geometry Composer and GAA Software must be used to 
generate an efficiency calibration file appropriate for the object being 
assayed.  The desired calibration parameters can be loaded and saved with 
the spectral data.  The spectral data file can then be analyzed to determine 
nuclide activity concentration. 
From the GAA window menu, choose Calibrate.  Select Load from the 
Calibrate menu.  This will display the Load Calibration dialog box.  The 
File Names section in this dialog box will contain a list of all calibration 
files currently stored in the directory specified by the environment 
variable CALFILES. 
 
When the Load Calibration dialog box is first displayed, the boxes labeled 
Energy/Shape and Efficiency will contain a check mark, Leave these boxes 
checked. 

14.2.15 Analyzing a Spectral Data File 
After opening a CAM file datasource and loading the appropriate 
efficiency calibration parameters, spectral data analysis can be performed. 
 The Analyze options in the GAA window menu bar can be used to 
perform these analyses. 
 
Choose Analyze in the GAA window menu bar to display the Analyze menu. 
 Next, choose Execute Sequence and select the sequence specified for what 
you are counting. 

14.2.16 Exiting the GAA Application 
When all spectral data analyses have been completed, click on File in the 
GAA window menu bar.  Select Close from the File menu.  If a datasource 
with unsaved changes was still open in the GAA window, a message 
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screen will be displayed asking whether the latest changes should be 
saved.  Respond appropriately to any such message.  
  
If you are shutting down the system, before completely exiting from GAA, 
turn off the high voltage to the detector by reversing the steps for applying 
high voltage in Section 14.2.3. The detector high voltage will remain on once 
the system has been setup for operations and is not typically shut down 
unless the system is scheduled for warm-up, transportation/movement 
throughout the site, and/or shipping, or an error occurs. 

14.3 In-Situ Use and Generation of In-Situ Object Counting System Models 
 14.3.1 General Information 

Several of CABRERA’s HPGe detectors may be used for in situ gamma 
spectroscopy applications.  In situ applications require use of portable 
detectors with multi-attitude, i.e. ‘Big MAC’cryostats. 

14.3.3ISOCS Applications 
Consult with a SME or the Gamma Spec Program Manager for proper setup 
and use of a portable HPGe detector. 

14.3.4 Big MAC Cryostat and Dewars 
The Big MAC dewer must be filled with LN2 every 2-3 days. When filling a 
Big MAC cryostat with LN2, be sure to follow the fill and vent instructions 
provided near the two vents.  The position of the vent cap depends upon the 
vertical orientation of the cryostat (detector facing up / facing down).  If the 
detector is horizontal, either port may be used for fill or vent, but once 
assigned, you should not alternate. 

14.3.5 ISOCS Modeling 

Spectra files collected with an ISOCS unit will require a source mode, and 
monte carlo efficiency file created by Canberra’s Geometry Composer 
software.  All ISOCS® source models will be created and/or reviewed by a 
qualified NDA SME prior to their use. 

Documentation will be provided for all ISOCS® models which will state the 
particular source specifications, underlying assumptions, and design 
dimensions for each model. 

14.3.6 Loading an ISOCS Calibration File 
Follow the instructions in Section 14.2.14.  However, for ISOCS use, the 
dialog box labeled “Energy/Shape” needs to be unchecked. This will allow 
new efficiency calibration parameters to be loaded without changing the 
original energy/shape calibration, which is appropriate for ISOCS use of the 
detector.  Use the vertical scroll bar in the File Names section until the 
desired calibration file name is shown, then double click on that file name.  
This will exit the Load Calibration dialog box, and load the efficiency 
calibration parameters from the selected file into the open CAM file 
datasource. 

14.4 Daily Quality Control 
14.4.1 A Daily QC Calibration Check is performed with an operational check 
source at the start of each field measurement shift.  The check source should 
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be placed at a reproducible position relative to the detector end-cap.  A 
typical arrangement for a lab QC jig is an empty marinelli beaker with the 
sources attached and/or positioned with its interior in a constant geometry. 
14.4.2 Save the QC file with the active date in the filename to the project QA 
folder and transfer the results into the project QAF file using the Quality 
Assurance Editor program. This step can also be automated by editing the 
QC analysis sequence if it will minimize transfer errors. 
14.4.3 The specific QC parameters evaluated and the acceptable ranges of 
results are summarized in the following table: 
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QC Calibration Parameter Description  Acceptable Range of Results 
Low energy photopeak energy Within fixed energy limits1 

High energy photopeak energy Within fixed energy limits1 

Low energy photopeak FWHM2 Mean +/- 2 std. deviations3 
High energy photopeak FWHM2 Mean +/- 2 std. deviations3 
Low energy decay corrected activity Mean +/- 2 std. deviations3 
High energy decay corrected activity Mean +/- 2 std. deviations3 

 
Notes: 

1. Observed peak energies should typically be within ± 0.5 keV of theoretical 
(approx. ± 3 channel limits) 

2. FWHM stands for Full Width at Half Maximum.  It is the width of the energy 
peak, in keV, at one half of the peak amplitude, or height. 
3. The mean and standard deviation values for these QC parameters are 
established by performing a set of 10 initial counts.  Subsequent count results are 
then compared to the established “investigation level” range of [mean +/- 2 std. 
dev.] and “action level” range of [mean +/- 3 std. dev.].  The mean and standard 
deviation is updated after each transfer to the QAF file. 
 

14.4.4 If all QC parameter results are within the acceptable ranges, the 
gamma spectroscopy system shall be approved for routine use during the 
remainder of that day.  If any of the results are outside the applicable 
acceptable range, the QC Check count shall be repeated.  If the results of 
the second count are within the acceptable ranges, the gamma 
spectroscopy system shall be approved for routine use.  If the results of the 
second count are outside the acceptable ranges, the system shall be taken 
out of service until the problem can be resolved by the Gamma 
Spectroscopy Program Manager. 
14.4.5 QC parameter results from these daily QC Check counts are stored 
in a QA file and can be tabulated and plotted for long-term trending.  
Updated tables and plots shall be printed (hard copy or electronic) on a 
weekly basis and retained in a readily-accessible file.  The SME shall 
review the QC check data weekly for trending.  These printouts are 
intended to provide a record of stable system performance, or alert the 
user to possible problems. 
Unless this process is automated, the QAF file shall be saved after 
importing the day’s QC information prior to closing or it will require 
transfer again. 

 
15.0 CALCULATIONS 

 
This section is not applicable to this specific operating procedure. 
 

16.0 METHOD PERFORMANCE 
 

Please refer to section 14.0 of this operating procedure for information pertaining 
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to this section. 
 

17.0 POLLUTION PREVENTION 
 

This section is not applicable to this specific operating procedure. 
 

18.0 DATA ASSESSMENT AND QC ACCEPTANCE CRITERIA 
 

Please see Sections 12.7 and 14.4 for further details. 
 

19.0 CORRECTIVE ACTIONS FOR OUT-OF-CONTROL DATA 
 

Please see Sections 12.7 and 14.4 for further details. 
 

20.0 UNACCEPTABLE DATA CONTINGENCIES 
 

Please see Sections 12.7 and 14.4 for further details. 
 

21.0 WASTE MANAGEMENT 
 

This section is not applicable to this specific operating procedure. 
 

22.0 REFERENCES 
 

Canberra Instrumentation and Software Manuals 
 
“Department of Defense Quality Systems Manual for Environmental Laboratories, 
Final Version 4.2, October 2010” DoD Environmental Quality Workgroup, 
Department of Navy, Lead Service. 
 
*Further references as found in Attachment 1. 

 
23.0 ATTACHMENTS 
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Attachment I 
 

Gamma Spectroscopy Qualifications and Approvals 
 

Basic Principles and Knowledge 
Personnel shall have a basic understanding of gamma spectroscopy principles and equipment.  
Basic knowledge can be obtained by the review of appropriate gamma spectroscopy sections of 
the following references: 
 

1. Introduction to Health Physics by Herman Cember 

2. Radiation Detection and Measurement by Glen F. Knoll 

3. Measurement and Detection of Radiation by Nicholas Tsoulfanidis 

4. National Council on Radiation Protection and Measurement (NCRP) Report 58 “A Handbook of 
Radioactivity Measurement Procedures. 

5. Vendor Courses in Gamma Spectroscopy provided by Canberra, Ortec, etc. 

6. University/Academic Courses/Degrees in Health Physics, Nuclear Engineering, etc. and/or Gamma 
Spectroscopy 

7. Other appropriate publications as approved by Cabrera Services, Inc. (List here): 

 

Experience 
Individuals operating equipment shall have sufficient experience using Canberra-based gamma 
spectroscopy equipment (at least one year) and/or have demonstrated successful system setup 
and use of such equipment under the instruction of a CABRERA Subject Matter Expert. 
 
Approval of Qualifications 
I have observed the individual perform the successful setup and use of gamma spectroscopy 
equipment. 
 

Employee / Trainee:  
 (name) 
  

 (signature) 
Approval:  

  
CABRERA Subject Matter Expert Date 

 
 


